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AUTÓMATAS Y SISTEMAS DE CONTROL 
 
 

PRÁCTICA 2: INTRODUCCIÓN A MATLAB 
 
 
1.  CARACTERÍSTICAS BÁSICAS DE MATLAB 
 
• Funcionalidades básicas: 

- cálculo matricial 
- representaciones gráficas 

 
• Librerías específicas: toolboxes. 

- Simulink: simulación de sistemas dinámicos. 
- Control: análisis de sistemas y ajuste de bucles de control. 
- Matemática simbólica: opera con variables simbólicas. 

 
 
2. CÓMO ENCONTRAR AYUDA EN MATLAB 
 
Exis ten distintas formas de localizar ayuda en el entorno de Matlab: 
 
• Ayuda en línea 
Se accede a través de la ventana de comandos tecleando help nombrefunción . La ayuda se obtiene en 
modo texto. 
 
• Ventana de ayuda (help window) 
Constituye una manera más sencilla de localizar la misma información: las funciones están agrupadas en 
bloques y se proporciona un pequeño interfaz para navegar. 
 
• Ayuda HTML (help desk) 
Con una estructuración similar a la de la ventana de ayuda, es fácil acceder a la información y, además, 
ésta se presenta en modo gráfico y con ejemplos de utilización. 
 
• Ejemplos (examples and demos) 
Matlab proporciona ejemplos y demostraciones de sus principales funcionalidades. Siempre es accesible 
el código fuente, con lo que puede ser directamente reutilizado. 
 
- Comando lookfor (búsqueda de palabras clave) 
Aunque más complicado de utilizar, proporciona en ocasiones información extra. El comando lookfor 
permite buscar entre las descripciones de todas las funciones de Matlab, aquellas que contienen la palabra 
clave que indiquemos. 
 
 
3. VARIABLES Y MATRICES EN MATLAB 
 
Matlab soporta nombres de variable de hasta 19 caracteres, y distingue entre mayúsculas y minúsculas. 
 
El tipo de las variables puede ser: 

• Entero 
• Real 
• Complejo 
• Carácter 

... y es asignado automáticamente. 
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Una sentencia de creación de variable es, por ejemplo: 
 

>> pepe = 7 
 
pepe = 
 7 

 
Esta sentencia crea la variable entera pepe y le asigna el valor 7. Matlab muestra en pantalla el resultado 
de cada operación. Para evitarlo basta poner un punto y coma después de cada sentencia: 
 

>> pepe = 7; 
 
Todas las variables en Matlab son consideradas matrices. Las posibilidades que utilizaremos son: 

• Matriz n x m: matriz bidimensional 
• Matriz n x 1  ó 1 x n : vector (se maneja exactamente igual que una matriz) 
• Matriz 1 x 1: escalar (también se maneja exactamente igual que una matriz). 

 
 
La forma de definir una matriz en Matlab es elemento a elemento: 
 

>> A = [1 2 3; 4 5 6; 7 8 9] 
 
A = 
 1 2 3 
 4 5 6 
 7 8 9 

 
Como puede apreciarse en el ejemplo, los distintos elementos de una fila se separan mediante espacios (o 
comas) y las distintas filas se separan mediante puntos y coma. 
 
Algunas posibilidades de manejo de variables que ofrece Matlab: 
 
• comprobar el contenido de alguna variable: basta con teclear su nombre en la ventana de comandos 
 

>> pepe 
 
pepe = 
 7 

 
• listar todas las variables existentes en un determinado momento: comando who. 
 

>> who 
 
Your variables are: 
 
A         pepe 

 
• eliminar alguna variable de memoria: comando clear. 
 

» clear pepe 
» who 
 
Your variables are: 
 
A 
 
Podemos observar cómo la variable pepe  ha desaparecido de la memoria. 

 
 
 



Autómatas y sistemas de control 

  3 

4. MANEJO DE MATRICES  
 
Matlab ofrece bastantes facilidades para el manejo de matrices. Volviendo al ejemplo anterior: 
 

>> A = [1 2 3; 4 5 6; 7 8 9] 
 
A = 
 1 2 3 
 4 5 6 
 7 8 9 

 
• Podemos acceder a cualquier elemento de la matriz especificando fila y columna: 
 

» A (1,3) 
 
ans = 
     3 

 
Nota: ans es la variable por defecto donde Matlab guarda cualquier resultado; si hubiéramos deseado 
utilizar otra variable deberíamos haberlo especificado: 
 

» k = A(1,3) 
 
k = 
     3 

 
• También se puede acceder a toda una fila o toda una columna, utilizando el operador dos puntos. 
 
Este primer comando muestra todos los elementos de la fila 2: 
 

»  A(2,:) 
 
ans = 
     4     5     6 

 
Este segundo comando muestra todos los elementos de la columna 3: 

 
» A (:,3) 
 
ans = 
     3 
     6 
     9 

 
• O bien a grupos de filas y/o columnas: 
 
Este comando muestra los elementos de las filas 1 hasta la 2 y de las columnas 2 hasta la 3: 
 

» A(1:2,2:3) 
 
ans = 
 
     2     3 
     5     6 
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• También es posible modificar cualquier elemento de una matriz: 
 

» A(1,1) = 9 
 
A = 
 
     9     2     3 
     4     5     6 
     7     8     9 

 
• E incluso añadir elementos a una matriz dada: 
 

» A(4,4) = 1 
 
A = 
 
     9     2     3     0 
     4     5     6     0 
     7     8     9     0 
     0     0     0     1 

 
Podemos ver cómo los elementos no especificados se rellenan con ceros. 

 
 
5. PRINCIPALES OPERADORES ARITMÉTICOS 
 
Matlab ofrece una serie de operadores aritméticos válidos tanto para cálculo matricial como para cálculo 
escalar: 
 

• Suma:  + 
• Resta:  - 
• Producto: * 
• División: / 
• Traspuesta: ‘ 
• Potencia: ^ 

 
En algunas ocasiones podrán presentarse ambigüedades. Por ejemplo, al multiplicar dos matrices caben 
dos posibilidades: producto matricial o producto elemento a elemento. Veamos cómo se resuelven: 
 

» A = [1 2;3 4] 
 
A = 
 
     1     2 
     3     4 
 
» B = [2 4; 6 8] 
 
B = 
 
     2     4 
     6     8 
 
» C = A*B  % producto matricial 
 
C = 
 
    14    20 
    30    44 
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»  D = A.*B  % el punto indica operación elemento a elemento 
 
D = 
 
     2     8 
    18    32 

 
 

Localización de ayuda: la información sobre operadores puede ser encontrada en: 
Help Window -> Operators and special characters 

 
 
Además de los operadores comentados, existen una serie de funciones muy útiles en cálculo matricial: 
 
• obtención de la matriz inversa: función inv: 
 

» A = [1 2;3 4] 
 
A = 
 
     1     2 
     3     4 
 
» B = inv(A) 
 
B = 
 
   -2.0000    1.0000 
    1.5000   -0.5000 

 
• creación de una matriz de ceros o unos: funciones zeros  y ones: 
 

» A = zeros(1,4) 
 
A = 
 
     0     0     0     0 
 
» B = ones(2,3) 
 
B = 
 
     1     1     1 
     1     1     1 

 
• creación de un vector de términos crecientes o decrecientes: 
 

» a = [0:1:5] % inicio 0, fin 5, salto 1 
 
a = 
 
     0     1     2     3     4     5 
 
» a = [5:-1:0] % inicio 5, fin 0, salto -1 
 
a = 
 
     5     4     3     2     1     0 
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» a = [0:.2:1] % inicio 0, fin 1, salto .2 
 
a = 
 
         0    0.2000    0.4000    0.6000    0.8000    1.0000 

 
Podemos crear cualquier vector creciente o decreciente que deseemos. Esta operación será 
bastante útil para formar bases de tiempo sobre las que evaluar el valor de funciones. 
 

 
Localización de ayuda: la información sobre operaciones matriciales puede ser encontrada en: 

Help Window -> Elementary matrices and matrix manipulation. 
 
 
 
6. MODOS DE TRABAJO 
 
Matlab permite trabajar de dos maneras distintas: 
 
• Mediante la introducción directa de comandos: 
Tecleando comandos desde la ventana principal de Matlab podemos realizar operaciones paso a paso. 
Será el método de trabajo a emplear para hacer pruebas o bien para operaciones sencillas no repetitivas. 
 
• Mediante creación de programas (*.m) 
La misma secuencia de comandos que podríamos introducir desde la ventana principal puede archivarse 
en un fichero (que debe tener terminación ‘.m’) y ser ejecutado posteriormente desde la ventana de 
comandos sencillamente tecleando el nombre del fichero. 
 
Los programas creados pueden ser de dos tipos: 
- macros: programas que no tienen argumentos de entrada ni de salida. 
- funciones: programas con parámetros: ofrecen más versatilidad. 
 
 
7. FACILIDADES PARA LA PROGRAMACIÓN EN MATLAB 
 
En comparación con otros lenguajes de programación, Matlab ofrece muchas facilidades para el usuario. 
Básicamente, cabe destacar: 
 

• Elección automática del tipo de las variables  
• Dimensionamiento automático de las matrices 
• Posibilidad de manejar números complejos de modo intuitivo 
• Posibilidad de funcionamiento en modo interpretado (chequeo de sentencias) 
• Entorno de depuración integrado (últimas versiones) 

 
 
8. SENTENCIAS DE CONTROL: BUCLES, COMPARACIONES, ... EN MATLAB  
 
Se muestra a continuación la sintaxis de las principales sentencias de control de Matlab: 
 
Bucles: 
 

for variable = expresion 
 sentencias 
end 

 
while expresión 

  sentencias 
 end 
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Sentencia condicional if/else/elseif: 
 

if expresión 
 sentencias 
 
elseif expresión 

sentencias 
 

elseif expresión 
 sentencias 
 
else 
 sentencias 
end 

 
Nota: las claúsulas else y elseif no son necesarias. 

 
 
EJEMPLO: 
Deseamos crear una función Matlab que, a partir de una matriz dada, genere una matriz cuadrada 
añadiendo filas o columnas de ceros, según sea necesario. La función se llamará cuadra y se guardará en 
el fichero cuadra.m, en el directorio de cada usuario. 
 
Paso 1: creación del fichero cuadra.m 
 
Con la opción File->New->M-file o bien con el botón New se lanza el editor/depurador de código 
Matlab, donde crearemos nuestra función. 
 
El código de nuestra función tendrá el siguiente aspecto: 
 

% convierte una matriz en cuadrada añadiendo ceros 
function b = cuadra(a) 
 
b = a;   % copia matriz entrada 
 
[x,y] = size(b);  % obtiene dimensiones 
 
if x>y 
   b(:,y+1:x) = 0; % añade columnas 
 
elseif y>x 
   b(x+1:y,:) = 0; % añade filas 
 
end 
 
return 

 
Si analizamos un poco en detalle este código, encontraremos elementos que necesariamente deberemos 
incluir en cualquier función que deseemos crear: 
 

- Línea de comentario: es importante que la primera línea de una función contenga un texto 
explicativo, será la línea que se muestre al solicitar ayuda. Debe comenzar con el símbolo % . 

 
- Declaración de la función: es obligatoria en cualquier función: especifica los parámetros de 

entrada y salida. En macros no existe esta línea. 
 
- Cuerpo de la función: contiene todas las operaciones que deseemos realizar. 
 
- Return: sentencia de finalización de función. Se devolverá el valor que tenga asignada la variable 

que se especificó como salida (en este caso, la variable b).  
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Paso 2: Selección del directorio o carpeta donde guardar el programa 
 
El directorio donde se archivan por defecto las funciones de usuario puede no ser acces ible dependiendo 
de los sistemas. En nuestro caso deberemos utilizar el directorio de invitado correspondiente –lo ideal es 
crear un subdirectorio de funciones matlab-. El fichero se guardará con nombre cuadra.m (es importante, 
éste será el nombre con el que accedamos a la función). 
 
Paso 3: Modificación del path de Matlab 
 
Matlab necesita conocer en qué directorios existen programas de usuario. Para ello dispone de la variable 
path, que debemos modificar adecuadamente. La sentencia a emplear será: 
 

>> path (path, ’nuevodirectorio’) 
 
donde nuevodirectorio representa el directorio o carpeta donde se ha guardado el programa. Por ejemplo: 
 

>> path (path, ’c:\invitado\pepito\matlab’) 
 
Paso 4: Comprobación usando la función help 
 
Si hemos incluido la primera línea de comentario en nuestra función y hemos modificado la variable path 
adecuadamente, debemos obtener un resultado como éste: 
 

>> help cuadra 
 
convierte una matriz en cuadrada añadiendo ceros 

 
Paso 5: Utilización de la función con una matriz ejemplo 
 
Probaremos la función con una matriz cualquiera: 
 

» a = [1 2; 3 4; 5 6] 
 
a = 
 
     1     2 
     3     4 
     5     6 
 
» b = cuadra(a) 
 
b = 
 
     1     2     0 
     3     4     0 
     5     6     0 

 
 Vemos cómo se obtiene el resultado que esperábamos. 
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9. REPRESENTACIONES GRÁFICAS EN MATLAB 
 
Matlab ofrece facilidades para la creación de gráficos 2D y 3D. Estudiaremos en primer lugar la función 
plot, el medio más sencillo para realizar representaciones bidimensionales. 
 
Existen diferentes sintaxis para la función plot. Intenteramos mostrar su funcionamiento con un ejemplo: 
 
Supongamos que partimos de los siguientes datos iniciales: 
 

» a = [0:0.1:2*pi] % a: contiene 63 ángulos entre 0 y 2π 
» b = sin(a)  % b: contiene los valores del seno de a 
» c = cos(a)  % c: contiene los valores del coseno de a 

 
Comparemos dos formas de representar la función seno: 
 

>> plot (b);    >> plot (a,b); 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
El resultado es aparentemente el mismo, pero existe una gran diferencia que es posible observar 
comparando los ejes x de ambas gráficas: 
 
plot (b) representa los valores del vector b en el eje y frente a los índices (números de orden) de ese 
vector en el eje x; por eso el eje x toma valores que van desde 1 hasta 63.  
plot (a,b) representa los valores del vector b en el eje y frente a los valores correspondientes del vector a 
en el eje x; por eso el eje x toma valores entre 0 y 2π. 
 
Normalmente nos interesará más la segunda opción y la magnitud a representará la escala de tiempos. 
 
Veamos ahora de qué forma podríamos representar a la vez el seno y el coseno, bien sobre un gráfico o 
sobre 2 gráficos distintos. 
 
Si llamamos repetidamente a la función plot, el segundo gráfico borrará el primero, con lo cual no 
lograremos nuestro objetivo: 
 

>> plot (a,b); 
>> plot (a,c); 

 
Si deseamos que el segundo gráfico se muestre sobre una ventana distinta, debemos intercalar la 
instrucción ‘figure’. Esta instrucción crea una nueva ventana de dibujo sobre la que se mostrarán todos 
los gráficos que se pidan a continuación: 
 

>> plot (a,b); 
>> figure; 
>> plot (a,c); 
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En el caso de que deseemos representar ambas funciones sobre un mismo gráfico, será necesario 
intercalar la instrucción ‘hold on’ . Esta instrucción permite dibujar nuevos datos sobre los datos 
anteriores, sin borrarlos: 
 

>> plot (a,b); 
>> hold on; 
>> plot (a,c); 

 
El resultado de las instrucciones anteriores debería ser similar al siguiente: 
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Si, por último, deseamos representar ambas funciones sobre una misma ventana pero en gráficos 
separados, deberemos utilizar la instrucción ‘subplot’ . El formato de esta instrucción es el siguiente: 
 

subplot(filas, columnas, activar) 
 
Donde filas y columnas representa el número de filas y columnas de gráficos que queremos que 
aparezcan en nuestra ventana, y activar indica el gráfico sobre el que queremos dibujar. Si, por ejemplo, 
deseamos mostrar a la izquierda el gráfico del seno y a la derecha el gráfico del coseno, se deberá crear 
una ventana con dos columnas y una fila de gráficos, de acuerdo con las instrucciones siguientes: 
 

» subplot(1,2,1) % crea ventana 1x2 y selecciona primer gráfico 
» plot(a,b)  % representa el seno 
» subplot(1,2,2) % selecciona el segundo gráfico 
» plot(a,c)  % representa el coseno 

 
El resultado debería ser similar al que se muestra en la figura siguiente: 
 

 
 
 
Un último aspecto que será importante a la hora de obtener representaciones gráficas será la forma de 
incluir textos sobre estas representaciones. Las principales instrucciones a utilizar son: 

• title: escribe un título para el gráfico (en la parte superior). 
• xlabel: da un nombre al eje x del gráfico. 
• ylabel: da un nombre al eje y del gráfico. 
• legend:  leyenda: indica lo que representa cada trazo del gráfico. 
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La forma de utilizar estas instrucciones se puede encontrar en la ayuda de Matlab. Utilizaremos 
fundamentalmente las tres primeras instrucciones. Con ellas, y sobre el último gráfico realizado, se puede 
obtener un resultado como el siguiente: 
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De ahora en adelante, todos los gráficos que se incluyan en los informes de prácticas deberán incluir un 
título en el que se indiquen asignatura, curso y nombre de alumno similar al mostrado en este ejemplo. 
 
 

Localización de ayuda: la información sobre la función plot puede ser encontrada en: 
Help Desk -> Matlab functions by index -> plot 

Help Desk -> Matlab functions by subject -> Plotting and Data Visualization 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Autómatas y sistemas de control 

  12 

 
EJERCICIO MATLAB 
 
1. Crear una función Matlab que sea capaz de multiplicar dos matrices y obtener la matriz 

inversa del resultado 
 
La declaración de la función debe ser como la siguiente: 
 

function resultado = calcula (matriz1, matriz2) 
 
Nota: la función debe guardarse como calcula.m. 
 
 
2. Crear una función Matlab que, tomando como entrada un vector V cualquiera, represente en 

una misma ventana (subpl ot) los dos gráficos siguientes: 
• Gráfico 1: valores de cada elemento de V, de cada elemento de V al cuadrado y de cada 

elemento de V al cubo (eje y) con respecto al número de orden (eje x). 
• Gráfico 2: valores de V (eje y) con respecto a los valores de V2 (eje x). 

 
Se muestra el aspecto que deben tener los gráficos para un vector de entrada como el siguiente: 

» v = [0:0.1:1.5] % desde 0 hasta 1.5 en incrementos de 0.1 
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La declaración de la función debe tener este aspecto: 
 

function dibuja (v) 
 
Nota: la función debe guardarse como dibuja.m 
 
 
A incluir en el informe de la práctica: 

• Ejercicio 1: listado completo 
• Ejercicio 2: listado completo y gráfico obtenido para el siguiente vector de entrada: 

» v = [-1.5:0.1:1.5] % de –1.5 a 1.5 en incrementos de 0.1 


